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Oracle Business Intelligence Enterprise Edition (OBIEE) Plug-in for Analytic 
Workspace Manager lets you quickly create an OBIEE 10g repository that enables the 
OBIEE Server (and therefore any OBIEE client, including Dashboards, Answers, 
Delivers, and the MS Office Plug-in) to query Oracle Database 11g OLAP cubes.

In this document, most of the figures are screen captures that depict dialog boxes that 
you encounter in the process of using OBIEE Plug-in for Analytic Workspace Manager 
and Oracle BI Administration Tool. In the figures, red boxes enclose the aspects of the 
dialog box that the figure illustrates.

The examples shown in the figures use the OLAPTRAIN schema and the 
SALESTRACK analytic workspace. You can download scripts that install the schema 
and create the analytic workspace from the Oracle Technical Network (OTN) website 
at 
http://www.oracle.com/technetwork/database/options/olap/olap-dow
nloads-098860.html.

This document has the following topics.

■ Describing OBIEE Plug-in for Analytic Workspace Manager

■ Overview of Creating OBIEE Metadata from a Cube

■ Task 1: Exporting OBIEE Metadata from Analytic Workspace Manager

■ Task 2: Importing OBIEE Metadata into an OBIEE 10g Repository

■ Task 3: Specifying Aggregation Rules for Measures

■ Task 4: Creating a Group and Adding the Data Filter

■ Task 5: Configuring the Connection Pool

■ Task 6: (Optional) Verifying the Connection

■ Task 7: Saving the Repository

■ Task 8: Cleaning Up

■ Documentation Accessibility

Describing OBIEE Plug-in for Analytic Workspace Manager
This section describes OBIEE Plug-in for Analytic Workspace Manager. It contains the 
following topics.

■ Product Support

■ Supported Versions of Oracle Database
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■ What Is an Analytic Workspace Manager Plug-in?

■ What Does OBIEE Plug-in for Analytic Workspace Manager Do?

■ Requirements for Analytic Workspace Manager

■ Installing OBIEE Plug-in for Analytic Workspace Manager

Product Support
OBIEE Plug-in for Analytic Workspace Manager is a product of Oracle OLAP Cube 
Labs. Products of Oracle OLAP Cube Labs are delivered through Oracle Technical 
Network (OTN) without cost.

Supported Versions of Oracle Database
OBIEE Plug-in for Analytic Workspace Manager supports Oracle Database 11g, 
Release 1 (11.1), version 11.1.0.7 and later, and Oracle Database 11g, Release 2 (11.2).

What Is an Analytic Workspace Manager Plug-in?
Analytic Workspace Manager allows third parties to add new features by providing 
plug-ins. A plug-in is a program that is launched from Analytic Workspace Manager. 
Plug-ins share the database session with the instance of Analytic Workspace Manager. 
You can use Analytic Workspace Manager plug-ins to add to or otherwise alter cubes 
and dimensions, to define calculations, or for other purposes. Because a plug-in shares 
a database connection and can modify your model, or even your data, be sure to use 
plug-ins only from trusted sources. Analytic Workspace Manager plug-ins cannot 
obtain the password used to start the Oracle Database session.

What Does OBIEE Plug-in for Analytic Workspace Manager Do?
OBIEE Plug-in for Analytic Workspace Manager allows you to create the Physical, 
Business Model and Mapping, and Presentation layers of an OBIEE 10g repository. You 
can use the repository to query an Oracle Database 11g OLAP cube using SQL. A 
repository created by OBIEE Plug-in for Analytic Workspace Manager allows OBIEE to 
query all data in the cube, including summary level data and measure calculations.

OBIEE Plug-in for Analytic Workspace Manager does not alter the definition or 
content of your cubes or dimensions.

OBIEE Plug-in for Analytic Workspace Manager reads the definitions of one or more 
cubes in a single analytic workspace, and the dimensions of the cubes, from the Oracle 
Data Dictionary and generates OBIEE UDML code that be used by Oracle BI 
Administration Tool. The plug-in exports the cube metadata to the system clipboard or 
to a file.

Note: Oracle OLAP Cube Lab products are not supported by Oracle 
Support. Please post questions, bug reports, and enhancement 
requests on the OLAP Forum on OTN at 
http://forums.oracle.com/forums/forum.jspa?forumID=1
6. 

The Analytic Workspace Manager team actively monitors this forum. 
Be sure to start your posting with "OBIEE Plug-in for AWM".
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The plug-in includes dimension hierarchies in the exported metadata. It uses the 
following rules to determine the hierarchies to export.

■ If the dimension has a default hierarchy, then the plug-in exports that hierarchy.

- If the default hierarchy is a level-based hierarchy, then the plug-in also exports 
any other level-based hierarchy that shares the same lowest level as the 
default hierarchy.

- If the default hierarchy is a value-based hierarchy, then the plug-in exports 
only that value-based hierarchy. The value-based hierarchy appears as a flat 
list when you import it into an OBIEE repository.

■ If the dimension does not have a default hierarchy, then the plug-in exports the 
first hierarchy of the dimension.

- If the first hierarchy is a level-based hierarchy, then the plug-in also exports 
any other level-based hierarchy that shares the same lowest level as the first 
hierarchy.

- If the first hierarchy is a value-based hierarchy, then the plug-in exports only 
that value-based hierarchy. 

Figure 1 illustrates the movement of analytic workspace metadata from the Oracle 
data dictionary to the Common Enterprise Information Model in an OBIEE server.

Figure 1 OBIEE Plug-in for Analytic Workspace Manager Creates OBIEE Metadata

The plug-in generates a Grand Total logical level under each dimension in the 
Business Model and Mapping layer of an OBIEE repository. Under the logical level are 
logical columns for the attributes that apply to the dimension. In Analytic Workspace 
Manager, these attributes are mapped to different source columns for different levels 
of a hierarchy. For example, the Standard hierarchy of the Product dimension has six 
levels. For each level, the long description attribute of the dimension is mapped to a 
different column in the PRODUCTS relational table. The plug-in provides these Grand 
Total folders so that the model with attributes can pass the OBIEE consistency check.

OBIEE Plug-in for Analytic Workspace Manager also generates a data filter for each 
cube. OBIEE uses this data filter to force joins between dimension views and cube 
views, even when the dimension is not part of the query. This is necessary to generate 
optimal SQL for querying the cube.
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The methodology used to generate the OBIEE metadata is described in the technical 
white paper Using Oracle Business Intelligence Enterprise Edition with the OLAP Option to 
the Oracle Database 11g. You can download this paper from OTN at 
http://www.oracle.com/technology/products/bi/olap/Oracle_OLAP_11
g_BIEE_TWP.pdf.

Requirements for Analytic Workspace Manager
To use this Analytic Workspace Manager plug-in, your analytic workspace must meet 
the following requirements:

■ The default hierarchy of each dimension must be a level-based hierarchy.

■ Each dimension must have a long description attribute.

■ The Create Level Attribute Columns in Views option must be selected for the long 
description attribute of each dimension. (This option is on the General tab of the 
attribute.)

■ Each cube must have at least one measure.

Installing OBIEE Plug-in for Analytic Workspace Manager
To install OBIEE Plug-in for Analytic Workspace Manager, download the file 
obieeplugin.jar and copy it to the directory that is specified for plug-ins by 
Analytic Workspace Manager. You enable the use of plug-ins and specify the directory 
for plug-ins in the Configuration dialog box on the Tools menu of Analytic Workspace 
Manager. If you have enabled plug-ins, then the next time you start it, Analytic 
Workspace Manager recognizes the new plug-in.

You can download the plug-in from the Cube Labs section of the OTN website at 
http://www.oracle.com/technetwork/database/options/olap/index.ht
ml.

Overview of Creating OBIEE Metadata from a Cube
The following topics describe the tasks involved in creating OBIEE metadata from one 
or more cubes in Analytic Workspace Manager. 

■ Task 1: Exporting OBIEE Metadata from Analytic Workspace Manager on page 5.

■ Task 2: Importing OBIEE Metadata into an OBIEE 10g Repository on page 11.

■ Task 3: Specifying Aggregation Rules for Measures on page 14.

■ Task 4: Creating a Group and Adding the Data Filter on page 15.

■ Task 5: Configuring the Connection Pool on page 19.

■ Task 6: (Optional) Verifying the Connection on page 21.

■ Task 7: Saving the Repository on page 21.

■ Task 8: Cleaning Up on page 22.
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Task 1: Exporting OBIEE Metadata from Analytic Workspace 
Manager
The steps involved in exporting OBIEE metadata from Analytic Workspace Manager 
are described in the following topics.

■ Step 1: Select Cubes and Start OBIEE Plug-in for Analytic Workspace Manager

■ Step 2: Specify Names and Options

■ Step 3: Export the OBIEE Metadata for the Cubes

Step 1: Select Cubes and Start OBIEE Plug-in for Analytic Workspace 
Manager
To select cubes and start the plug-in, do the following.

1. In the Analytic Workspace Manager navigation tree, right-click an analytic 
workspace or a cube.

2. Select Export to OBIEE Administrator on the shortcut menu that appears.

OBIEE Plug-in for Analytic Workspace Manager finds the OLAP cubes in the Oracle 
Data Dictionary and determines if they are compatible with OBIEE. The plug-in 
automatically includes all of the dimensions of the cube in the metadata export.

OBIEE Plug-in for Analytic Workspace Manager displays a dialog box with the cube or 
cubes that you selected in the Selected Cubes list and other available cubes in the 
Available Cubes list.

Figure 2 shows the dialog box that OBIEE Plug-in for Analytic Workspace Manager 
displays when the user has selected the SALESTRACK analytic workspace. At first 
both the SALES_CUBE and the FORECAST cubes are in the Selected Cubes field. 
Figure 2 shows the dialog box after the user has moved the FORECAST cube to the 
Available Cubes field.
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Figure 2 Selecting a Cube to Export

Step 2: Specify Names and Options
To specify the names that you want the objects to have in the Physical, Business Model 
and Mapping, and Presentation layers of OBIEE, and to specify a naming option for 
logical tables and columns, do the following.

■ On the Export tab, enter the names in the Physical Database, Business Model, 
and Presentation Catalog fields. The names you specify must not already exist in 
the target OBIEE repository file. See Figure 3.

■ On the Options tab, select an option. You can specify whether to use the analytic 
workspace object names or descriptions as the names for the logical tables and 
columns in the OBIEE metadata. See Figure 4.

Figure 3 shows the Export Analytic Workspace SALESTRACK to OBIEE Administrator 
dialog box. The Physical Database, Business Model, and Presentation Catalog fields 
all contain the name SALESTRACK.
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Figure 3 Specifying Names for the OBIEE Layers

Figure 4 shows the Options tab with the Cube and Dimension Descriptions option 
selected.

Figure 4 Specifying Naming Options
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Step 3: Export the OBIEE Metadata for the Cubes
You can export the metadata for a cube or cubes in either of the following ways.

■ Export to the system clipboard. You can then paste the contents of the clipboard 
into an OBIEE repository. This option is described in "Exporting to the System 
Clipboard" on page 8.

■ Export to a file. You can then copy the contents of the file and paste them into an 
OBIEE repository or you can use the OBIEE Server nQUDMLExec utility to import 
the metadata into a repository. This option is described in "Exporting to a File" on 
page 9.

Exporting to the System Clipboard
To export the OBIEE metadata to the system clipboard, do the following.

1. Click the Export to Clipboard button.

2. (Optional) To view the exported text in the clipboard, click Yes in the Clipboard 
Copy Completed dialog box.

You can paste the contents of the clipboard into an OBIEE repository as described in 
"Importing OBIEE Metadata by Pasting It into the Repository" on page 12.

Figure 5 shows the Export Analytic Workspace SALESTRACK to OBIEE Administrator 
dialog box with the Export to Clipboard button emphasized.

Figure 5 Exporting to the Clipboard

The text exported by OBIEE Plug-in for Analytic Workspace Manager contains 
instructions for importing the metadata into OBIEE, text for the data filter, and OBIEE 
UDML code. In "Task 4: Creating a Group and Adding the Data Filter", you copy the 
text for the data filter from the clipboard and paste it into an OBIEE repository. Note 
that the instructions and the data filter are commented out using the # character. 
Figure 6 shows the system clipboard with the first several lines of the exported text.
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Figure 6 Contents of the System Clipboard

Exporting to a File
To export the OBIEE metadata to a file, do the following.

1. Click the Export to File button. See Figure 7.

2. In the Export to File dialog box, specify a filename and path and click Save. See 
Figure 8.

You can import the OBIEE metadata in the file by copying and pasting it into a 
repository or by using the nQUDMLExec utility, as described in "Importing OBIEE 
Metadata by Using the nQUDMLExec Utility" on page 12.

Figure 7 shows the Export Analytic Workspace SALESTRACK to OBIEE Administrator 
dialog box with the Export to File button emphasized.
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Figure 7 Exporting to a File

Figure 8 shows the Export to File dialog box with a path and filename in the Save to 
File field.

Figure 8 Saving the Exported File

The file created by OBIEE Plug-in for Analytic Workspace Manager contains 
instructions for importing the metadata into OBIEE, text for the data filter, and OBIEE 
UDML code. Later, in "Task 4: Creating a Group and Adding the Data Filter", you copy 
the text for the data filter from the exported file and paste it into an OBIEE repository. 
Note that the instructions and the data filter are commented out using the # character.

Figure 9 shows the exported file in Windows Notepad.



11

Figure 9 Exported File in Windows Notepad

Task 2: Importing OBIEE Metadata into an OBIEE 10g Repository
You can import the OBIEE metadata for the analytic workspace cube or cubes into an 
OBIEE 10g repository by either pasting the exported metadata into the repository or by 
using the nQUDMLExec utility.

The following topics describe these methods.

■ Importing OBIEE Metadata by Pasting It into the Repository.

■ Importing OBIEE Metadata by Using the nQUDMLExec Utility.
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Importing OBIEE Metadata by Pasting It into the Repository
After you have exported the OBIEE metadata to the system clipboard or a file, you can 
paste the metadata into an OBIEE repository. To paste the metadata, do the following.

1. Create a new OBIEE repository or open an existing one. To create a new repository, 
do the following.

a. On the Start menu, select Programs, Oracle Business Intelligence, and then 
Administration.

b. In the Oracle BI Administration Tool dialog box, on the File menu, select New.

c. In the New Repository dialog box, in the File Name field, enter a name for the 
repository.

d. Click Save.

2. Paste the OBIEE metadata into the Physical layer of the repository. Do one of the 
following.

■ Paste the exported metadata in the system clipboard into the repository.

■ Copy the contents of the file containing the exported metadata and paste it 
into the repository.

Oracle BI Administration Tool populates the Presentation, Business Modeling and 
Mapping, and Physical layers with the imported metadata. Figure 10 shows the 
SALES_CUBE repository with the pasted metadata.

Figure 10 OBIEE Repository with Imported Metadata

Importing OBIEE Metadata by Using the nQUDMLExec Utility
Another method for importing the OBIEE metadata is to use the nQUDMLExec utility 
and the file exported by OBIEE Plug-in for Analytic Workspace Manager. Exporting to 

Note: If you open an existing repository, the metadata that you are 
importing should not already exist in the Presentation, Business 
Modeling and Mapping, and Physical layers of the repository.
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a file is described in "Exporting to a File" on page 9. This section describes the OBIEE 
10g nQUDMLExec command and contains examples of using it.

Running the nQUDMLExec Utility
To run the nQUDMLExec utility, at the command line enter nQUDMLExec and the 
options that you want.

With the options, you can import the file into an existing repository or create a new 
repository. The nQUDMLExec.exe file is in the server\Bin directory of the OBIEE 
10g installation.

The syntax of the nQUDMLExec command is the following.

nQUDMLExec [-U [userid]] [-P [password]] -I input_script_pathname
[-B base_repository_pathname] -O output_repository_pathname [-8]

The arguments to the command are the following.

-U userid
The userid value is the OBIEE administrator user ID. You need to specify the user ID 
only if you also use the base_repository_pathname argument.

-P password
The password value is the OBIEE administrator password. Use this argument only if 
you also use the userid argument.

-I input_script_pathname
The input_script_pathname value is the name of the file that contains the metadata you 
exported from Analytic Workspace Manager, as shown in Figure 8 on page 11.

-B base_repository_pathname
The base_repository_pathname value is the name of a new or existing OBIEE repository 
file.

-O output_repository_pathname (optional)
The output_repository_pathname value is the name of a new or existing OBIEE 
repository file. This argument is optional if you use the -B argument.

The following are the options for the use of the -B and -O arguments.

■ If you do not specify an output_repository_pathname file, then you must specify a 
base_repository_pathname file. OBIEE adds the cube or cubes to the repository 
specified by the base_repository_pathname file.

■ If you specify an output_repository_pathname file, then OBIEE creates a file with the 
specified name. If you do not also specify a base_repository_pathname file, then the 
output_repository_pathname file contains only the contents of the 
input_script_pathname file.

■ If you specify an output_repository_pathname value and a base_repository_pathname 
file, then OBIEE creates a file with the output_repository_pathname name. That file 
contains the merged contents of the base_repository_pathname file and the 
input_script_pathname file.

-8
This specifies the UTL-8 character set.
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Examples of Using the nQUDMLExec Command
The following examples run the nQUDMLExec command from the Microsoft 
Windows command prompt. The first example creates the new repository file 
SALESTRACK_OBIEE.rpd from the exported file SALESTRACK_OBIEE.txt.

C:> nqudmlexec -I SALESTRACK_OBIEE.txt -O SALESTRACK_OBIEE.rpd

The next example creates the new repository file SALES_AND_FORECAST.rpd from 
the repository file SALESTRACK_OBIEE.rpd and the exported file 
FORECAST_OBIEE.txt.

C:> nqudmlexec -U administrator -P password -I FORECAST_OBIEE.txt 
-B SALESTRACK_OBIEE.rpd -O SALES_AND_FORECAST.rpd

Task 3: Specifying Aggregation Rules for Measures
To have access to the aggregated data of the measures of the cube, you must specify 
aggregations rules for the measures. Also, if attribute columns are in the Presentation 
Catalog, then specifying an aggregation rule for a measure enables GROUP BY for 
reporting measure values by attribute, for example, to break out members of the 
Product dimension by Color and Size attributes.

Not all measures are suitable for aggregation, however. It might make sense to allow 
SUM … GROUP BY of a measure such as Sales but it probably does not make sense to 
aggregate measures that are percentages or rankings.

To specify a default aggregation rule for a measure logical column, do the following.

1. In the navigation tree of the Business Model and Mapping layer, double-click a 
logical column for a measure.

2. In the Logical Column dialog box, select the Aggregation tab.

3. Select one of the aggregate functions from the Default Aggregation Rule list.

4. Click OK.

Figure 11 shows the Sales measure logical column selected in the Business Model and 
Mapping navigation tree.
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Figure 11 Selecting a Measure

Task 4: Creating a Group and Adding the Data Filter
For OBIEE to create the correct style of SQL for cube and dimension views, you must 
add an OBIEE data filter on the logical table for the cube. This data filter forces joins 
between dimension and cube views when a dimension is not represented in a query.

You should add the data filter to the logical table for the cube in the Business Modeling 
and Mapping layer. You can enforce it for any user or group that queries the cube.

The figures in this task illustrate an example of adding the data filter. The example 
creates a group named OLAPUSER and adds the data filter to that group. It grants 
permission to query the cube to a user by adding the user to the group.

To create a group and add the data filter, do the following.

1. Create a user group. To create a new user group, do the following in Oracle BI 
Administration Tool.

a. On the Manage menu, select Security.

b. In the Security Manager dialog box, in the Security navigation tree, select 
Groups. On the Action menu, select New and then Group.

c. In the Name field of the Group dialog box, enter a name for the group.

d. Click Permissions.

Figure 12 shows the Group dialog box with OLAPUSER in the Name field.
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Figure 12 Creating the OLAPUSER Group

2. In the User/Group Permissions - Security Group dialog box, click the Filters tab 
and then click Add.

Figure 13 shows the Filters tab of the User/Group Permissions - Security Group 
dialog box.

Figure 13 Adding a Data Filter

3. In the Browse dialog box, do the following.

a. Select the Business Model tab.

b. In the navigation tree, select the logical table that represents the cube.

c. Click Select.

Figure 14 shows the Browse dialog box with the Sales Cube logical table selected 
in the navigation tree on the Business Model tab.
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Figure 14 Selecting a Cube

4. In the User/Group Permissions - Security Group dialog box, click the ellipsis (…) 
button. Figure 15 shows that dialog box with the ellipsis button emphasized.

Figure 15 Opening the Expression Builder to Edit the Data Filter 

5. Copy the data filter from the metadata exported by OBIEE Plug-in for Analytic 
Workspace Manager. Be sure to avoid selecting the # comment delimiter character 
in the line that begins the data filter text. Figure 16 shows the system clipboard 
with the data filter text selected.
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Figure 16 Copying the Data Filter from the Clipboard

6. Add the data filter by doing the following.

a. Paste the data filter in the main field of the Expression Builder, as shown in 
Figure 17, and click OK.

b. In the User/Group Permissions dialog box for the group, click OK.

c. In the Group dialog box, click OK.

Figure 17 Pasting the Data Filter in the OBIEE Expression Builder

7. Add users to the group as appropriate. To add a user to a group, do the following.

a. In the Security Manager dialog box, in the Security navigation tree, select 
Users. On the Action menu, select New and then User.

b. On the User tab of the User dialog box, in the User Name field, enter a name 
for the user.
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c. In the Group Membership field, select the appropriate group or groups.

d. Click OK.

e. In the Security Manager dialog box, on the Action menu, select Close.

Figure 18 shows the User dialog box with Sales Cube User entered in the User Name 
field and with the OLAPUSER group selected in the Group Membership field.

Figure 18 Adding a User to the OLAPUSER Group

Task 5: Configuring the Connection Pool
OBIEE Plug-in for Analytic Workspace Manager creates a connection pool in the 
Physical layer in the repository. The connection pool contains all of the connection 
information that OBIEE needs to connect to an Oracle Database instance except for the 
database user name and password. Before using the repository, set the user name and 
password for the Shared Logon option.

To configure the connection pool properties, do the following.

1. Open the connection pool properties by double-clicking the connection pool in the 
Physical layer in the Oracle BI Administration Tool dialog box for the repository. 
In Figure 19, the connection pool is SALESTRACK_LOCAL.
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Figure 19 Selecting the Connection Pool

2. In the Connection Pool dialog box, on the General tab, do the following.

a. From the Call Interface list, select OCI 10g/11g.

b. Select the Shared Logon option and enter the user name and password for 
your database instance.

c. Click OK.

Figure 20 shows the Connection Pool dialog box for SALESTRACK_LOCAL.

Figure 20 Specifying Connection Pool Properties
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Task 6: (Optional) Verifying the Connection
After you have configured the connection pool, you can verify the connection.

To verify the connection, do the following. 

1. Right-click a view in the Physical layer.

2. Select Update Row Count or View Data.

Figure 21 shows the shortcut menu for the CHANNEL_VIEW view.

Figure 21 Verifying the Connection

Task 7: Saving the Repository
To save the repository, in the Oracle BI Administration Tool dialog box, on the File, 
select Save.

When you click Save, a message appears that asks if you want to check global 
consistency. To verify global consistency, click Yes. The Consistency Check Manager 
dialog box appears and displays a warning with the error number 39028. You can 
safely ignore this warning. Click Close to close the Consistency Manager.

Note: For verifying the connection by updating a row count, select a 
physical table for a dimension. Updating the row count for the 
physical table for a fact table, such as SALES_CUBE_VIEW, which is 
visible in Figure 19, can take more time.
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Task 8: Cleaning Up
At this point, users can query the cube. You might want to review the OBIEE metadata 
and make a few adjustments to accommodate your preferences. For example, you 
might want to review the columns that represent attributes and decide if they are 
useful to your users. Some attributes, such as those used for time series calculations or 
for sorting, might not be useful to users. Consider removing them from the 
Presentation Catalog.

Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible to all users, including users that are disabled. To that end, our 
documentation includes features that make information available to users of assistive 
technology. This documentation is available in HTML format, and contains markup to 
facilitate access by the disabled community. Accessibility standards will continue to 
evolve over time, and Oracle is actively engaged with other market-leading 
technology vendors to address technical obstacles so that our documentation can be 
accessible to all of our customers. For more information, visit the Oracle Accessibility 
Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, some screen readers may not always read a line of text 
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or 
organizations that Oracle does not own or control. Oracle neither evaluates nor makes 
any representations regarding the accessibility of these Web sites.

Deaf/Hard of Hearing Access to Oracle Support Services
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call 
Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle 
technical issues and provide customer support according to the Oracle service request 
process. Information about TRS is available at 
http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone 
numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html.
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